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Module 1: Introduction to 
Power BI


Overview of Power BI and its components



Power BI is a business analytics tool developed by Microsoft that 
provides interactive visualizations and business intelligence 
capabilities. It enables users to connect to various data sources, 
transform and clean the data, create interactive reports and 
dashboards, and share them with others.



Power BI consists of several key components that work together to 
provide a comprehensive business intelligence solution. Let's 
explore them

 Power BI Desktop: It is the primary authoring tool where users can 
create complex data models, design interactive reports, and 
build visually appealing dashboards. Power BI Desktop provides 
a rich set of data transformation capabilities, including data 
shaping, modeling, and advanced calculations

 Power BI Service: Also known as Power BI online, it is a cloud-
based platform where users can publish, share, and collaborate 
on Power BI reports and dashboards. Power BI Service allows 
users to access their reports from anywhere, on any device, and 
provides additional functionalities like data refresh, scheduling, 
and security features

 Power BI Mobile: It is a mobile application available for iOS and 
Android devices that allows users to access and view their Power 
BI reports and dashboards on the go. Power BI Mobile provides a 
responsive and optimized experience for mobile devices, 
enabling users to stay connected to their business insights 
wherever they are

 Power BI Report Server: It is an on-premises solution that allows 
organizations to host and distribute Power BI reports within their 
own network infrastructure. Power BI Report Server provides the 
flexibility and security required by organizations that cannot or 
choose not to store their data in the cloud.
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 Power Query: It is a data connectivity and transformation tool 
that is integrated into Power BI Desktop. Power Query allows 
users to connect to various data sources, such as databases, 
Excel files, web services, and more. It provides an intuitive 
interface to shape and transform the data before loading it into 
Power BI

 Power Pivot: It is a data modeling tool within Power BI Desktop 
that allows users to create complex data models by combining 
multiple data sources, defining relationships, and creating 
calculated columns and measures. Power Pivot uses the 
VertiPaq in-memory engine to optimize data storage and query 
performance

 Power View: It is a data visualization tool within Power BI that 
allows users to create interactive reports with a variety of 
visualizations like charts, tables, maps, and slicers. Power View 
provides an intuitive drag-and-drop interface to design visually 
appealing and insightful reports

 Power Map: It is a geospatial visualization tool that allows users 
to explore and analyze data on a 3D map. Power Map enables 
users to plot data points on a map, visualize patterns and trends, 
and create interactive tours to present their insights

 Power Q&A: It is a natural language query tool that allows users 
to ask questions in plain English and get instant visual responses. 
Power Q&A uses advanced algorithms to interpret the questions, 
understand the underlying data, and generate the appropriate 
visualizations.


These components work together to provide a comprehensive and 
user-friendly business intelligence solution, empowering users to 
connect to data, transform it into meaningful insights, and share 
them with others through interactive reports and dashboards.
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Exploring the Power BI ecosystem



Exploring the Power BI ecosystem involves understanding the 
various components and resources available to users for data 
analysis, visualization, and collaboration. Here's a breakdown of the 
key elements

 Power BI Desktop: Power BI Desktop is the primary tool for 
creating and authoring reports and dashboards. It provides a 
rich set of features, including data modeling, data 
transformation, creating visualizations, and defining 
calculations. Users can connect to various data sources, shape 
and transform the data, and design interactive visualizations 
using a drag-and-drop interface

 Power BI Service: Power BI Service, also known as Power BI online, 
is a cloud-based platform for sharing, collaborating, and 
managing Power BI content. Once reports and dashboards are 
created in Power BI Desktop, they can be published to Power BI 
Service. It provides features such as data refresh, scheduled 
data updates, sharing and collaboration options, and advanced 
security settings. Users can access and interact with their reports 
and dashboards using a web browser

 Power BI Mobile: Power BI Mobile is a mobile application available 
for iOS and Android devices. It allows users to access their Power 
BI content on the go. With the mobile app, users can view and 
interact with reports and dashboards, receive notifications and 
alerts, and stay connected to their business insights anytime 
and anywhere

 Power BI Gateway: Power BI Gateway is a bridge between on-
premises data sources and the cloud-based Power BI Service. It 
allows users to securely connect to on-premises databases, files, 
and other data sources, and refresh data in Power BI reports and 
dashboards. The gateway ensures that data is up to date and 
available for analysis in real-time.
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 Power Query: Power Query is a data transformation and mashup 
tool available in Power BI Desktop and Power Query Editor. It 
enables users to connect to a wide range of data sources, 
including databases, files, web services, and APIs. Power Query 
provides an intuitive interface for shaping, cleaning, and 
transforming data before it is loaded into the data model

 Power Pivot: Power Pivot is a powerful data modeling engine that 
enables users to create sophisticated data models within Power 
BI Desktop. It allows users to combine multiple data sources, 
define relationships between tables, and create calculated 
columns and measures. Power Pivot uses an in-memory engine 
called VertiPaq for fast query performance

 Power BI Visuals Marketplace: The Power BI Visuals Marketplace is 
an online gallery where users can discover and download 
custom visualizations created by the community and Microsoft. 
These visualizations can be added to Power BI reports and 
dashboards, enhancing the range of available visual options 
beyond the built-in visuals

 Power BI AppSource: Power BI AppSource is a marketplace for 
finding and deploying pre-built solutions, apps, and content 
packs for Power BI. It offers a wide range of industry-specific 
templates, dashboards, and reports that can be quickly 
integrated into Power BI to accelerate analysis and reporting for 
specific business scenarios

 Power BI Community: The Power BI Community is an online 
community platform where users can connect, collaborate, and 
learn from each other. It provides discussion forums, blogs, 
knowledge bases, and resources where users can share ideas, 
ask questions, and find solutions to their Power BI-related 
challenges.



By exploring and utilizing these components and resources within 
the Power BI ecosystem, users can leverage the full capabilities of 
Power BI for data analysis, visualization, and collaboration to drive 
insights and informed decision-making within their organizations.




08

Installing and setting up Power BI Desktop and 
Power BI Service



Installing and setting up Power BI Desktop and Power BI Service 
involves the following steps:



Installing Power BI Desktop

 Visit the Microsoft Power BI website (powerbi.microsoft.com) and 
navigate to the "Downloads" section

 Click on the "Download free" button to initiate the download of 
the Power BI Desktop installer

 Once the download is complete, run the installer file
 Follow the on-screen instructions to install Power BI Desktop on 

your computer
 Once the installation is complete, launch Power BI Desktop.



Setting up Power BI Service

 Open a web browser and go to the Power BI Service website 
(app.powerbi.com)

 If you already have a Microsoft account, sign in using your 
credentials. If not, create a new Microsoft account

 After signing in, you will be directed to the Power BI Service home 
page

 If you are a new user, you may need to provide additional 
information and agree to the terms of service

 Once you have completed the initial setup, you can start 
exploring the Power BI Service interface.



09

Connecting Power BI Desktop to Power BI Service

 In Power BI Desktop, click on the "Publish" button located in the 
Home tab or go to File > Publish

 Sign in with your Microsoft account associated with Power BI 
Service

 Select the workspace where you want to publish your report or 
create a new workspace

 Specify a name and description for the report and choose the 
appropriate privacy settings

 Click on the "Publish" button to upload your report to Power BI 
Service.



Syncing Power BI Desktop with Power BI Service

 In Power BI Desktop, click on the "Publish" button or go to File > 
Publish

 Sign in with your Microsoft account if you haven't already
 Select the workspace where you want to publish the report or 

create a new workspace
 Choose a name and description for the report and select the 

desired privacy settings
 Click on the "Publish" button to upload the report to Power BI 

Service
 Once the upload is complete, you can access and manage your 

report in Power BI Service.



Remember to keep Power BI Desktop and Power BI Service up to 
date by installing the latest versions or updates provided by 
Microsoft. Regularly check for new versions to access the latest 
features and improvements in both tools.
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Importing data from various sources into Power 
BI Desktop



Power BI Desktop provides a wide range of options for importing 
data from various sources. Here's an overview of how to import 
data from different sources into Power BI Desktop

 Importing from Files
 Excel: In Power BI Desktop, click on the "Get Data" button on 

the Home tab, select "Excel" from the list of available 
connectors, and choose the Excel file you want to import. 
Power BI will analyze the file and display a preview of the data. 
Select the desired sheets or tables and click "Load" to import 
the data into Power BI

 CSV/Text: Use the "Get Data" button, choose "Text/CSV" from 
the list of connectors, and select the CSV or text file. Configure 
the file's delimiter and other settings, preview the data, and 
click "Load" to import it

 Importing from Databases
 SQL Server Database: Click on "Get Data," select "SQL Server" 

from the connectors list, provide the server name and 
credentials, and choose the database and tables/views to 
import

 Other Databases: Power BI supports connections to a variety 
of databases, including MySQL, Oracle, PostgreSQL, and more. 
Select the appropriate connector, provide the necessary 
connection details, and import the desired tables or views

 Importing from Online Services
 Azure SQL Database/Data Warehouse: Use the "Get Data" 

button, choose "Azure" from the connectors list, and select 
"Azure SQL Database" or "Azure SQL Data Warehouse." Provide 
the connection details and import the required tables

 SharePoint Online: Select "SharePoint Online List" from the 
connectors list, provide the SharePoint site URL and 
authentication details, and choose the desired list to import.


Module 2: Data Preparation 
and Modeling
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 Importing from Cloud Services and APIs
 Azure Blob Storage: Use the "Get Data" button, select "Azure" 

from the connectors list, and choose "Azure Blob Storage." 
Provide the necessary information, such as account name 
and container, and import the desired files

 Web: Power BI supports importing data from web pages and 
web APIs. Choose the "Web" connector, enter the URL of the 
web page or API, specify the required parameters, and 
configure data retrieval options

 Importing from Other Sources
 Other File Formats: Power BI can import data from various file 

formats like XML, JSON, and SharePoint folders. Select the 
appropriate connector, provide the necessary information, 
preview the data, and import it

 Other Sources: Power BI Desktop offers a wide range of 
connectors, including Salesforce, Google Analytics, Dynamics 
365, and more. Explore the available connectors, select the 
desired one, and provide the required information to import 
the data.



After selecting the data source and connecting to it, Power BI 
provides a data preview and transformation options through the 
Power Query Editor. In the Power Query Editor, you can perform data 
shaping, cleaning, merging, and other transformations before 
loading the data into the Power BI data model.

Once the data is imported and transformed, you can proceed to 
create visualizations, build relationships, define calculations, and 
design interactive reports and dashboards in Power BI Desktop.
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Transforming and shaping data using Power 
Query Editor



Power Query Editor is a powerful tool within Power BI Desktop that 
allows you to transform and shape your data before loading it into 
the Power BI data model. Here's an explanation of how to use Power 
Query Editor for data transformation

 Accessing Power Query Editor
 In Power BI Desktop, click on the "Edit Queries" button in the 

Home tab. This will open the Power Query Editor window
 Alternatively, you can right-click on a query in the Queries 

pane on the left side of the screen and select "Edit" to open 
the Power Query Editor for that specific query

 Connecting to Data Sources
 Power Query Editor displays the list of queries available in 

your current Power BI Desktop file. To add a new data source, 
click on the "Get Data" button in the Home tab and choose the 
desired data source from the list. Follow the prompts to 
connect to the data source and import the data

 Applying Transformations
 Power Query Editor provides a wide range of transformation 

options. These include
 Filtering and Sorting: You can filter rows based on specific 

criteria and sort data in ascending or descending order
 Removing Columns: You can remove unnecessary 

columns from the dataset
 Adding Columns: You can create new calculated columns 

using formulas or perform operations on existing columns
 Splitting and Merging Columns: You can split a column into 

multiple columns based on delimiters or combine multiple 
columns into a single column

 Grouping and Aggregating: You can group rows based on 
specific criteria and calculate aggregate functions like 
sum, count, average, etc

 Pivoting and Unpivoting: You can pivot data, converting 
column values into new columns, or unpivot data, 
transforming multiple columns into a single column and 
attribute-value pairs

 Data Type and Format Changes: You can change the data 
types and formats of columns

 Conditional Transformations: You can apply 
transformations based on conditions using if-else logic.
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 Previewing and Applying Transformations
 Power Query Editor provides a preview of the data at each 

step of transformation, allowing you to see the impact of 
applied changes. You can review and modify each step in the 
Applied Steps pane on the right side of the window

 To apply the transformations, click on the "Close & Apply" 
button. This will load the transformed data into the Power BI 
data model

 Modifying Applied Steps
 If you need to make changes to the applied transformations, 

you can reopen the Power Query Editor by clicking on the "Edit 
Queries" button

 In the Power Query Editor, you can modify or delete existing 
steps, add new steps, or rearrange the order of steps. Power 
Query Editor will automatically update the data based on the 
modified steps.



Power Query Editor provides a user-friendly interface with a variety 
of transformation options, allowing you to clean, reshape, and 
enhance your data for better analysis and reporting. The 
transformations performed in Power Query Editor are non-
destructive, meaning the original data source remains unchanged, 
and the applied steps can be modified or removed at any time.
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Creating relationships between tables



Creating relationships between tables is a crucial step in Power BI 
that enables you to establish connections and define how data 
from different tables relate to each other. By creating relationships, 
you can combine data from multiple tables to build comprehensive 
reports and visualizations. Here's an explanation of how to create 
relationships between tables in Power BI

 Understanding the Data Model
 In Power BI Desktop, the data model is where you define and 

manage tables, columns, and relationships. To access the 
data model, click on the "Modeling" tab at the top of the 
screen

 Adding Tables to the Data Model
 To create relationships, you need to have multiple tables in 

the data model. You can add tables by connecting to 
different data sources and importing the required data using 
Power Query or by creating calculated tables using DAX 
formulas

 Identifying Columns for Relationships
 Determine the columns in the tables that have common 

values and can be used to establish relationships. These 
columns are often referred to as primary keys and foreign 
keys

 A primary key is a unique identifier in a table, while a foreign 
key is a column that references the primary key of another 
table.
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 Creating Relationships
 In the data model view, click on the "Manage Relationships" 

button in the Modeling tab. This opens the Manage 
Relationships window

 In the Manage Relationships window, click on the "New" button 
to create a new relationship

 Select the primary table from the dropdown list, which is the 
table containing the primary key column

 Choose the foreign table from the second dropdown list, 
which is the table containing the foreign key column

 Next, select the primary key column and the corresponding 
foreign key column from their respective dropdown lists

 Define the cardinality of the relationship, which specifies how 
the tables are related (one-to-one, one-to-many, or many-
to-many)

 Optionally, you can enable cross-filtering and bidirectional 
filtering based on your analysis requirements

 Click on the "OK" button to create the relationship
 Verifying and Managing Relationships

 Once created, the relationships are displayed in the Manage 
Relationships window. You can review and modify the 
relationships if needed

 To verify the relationships visually, switch to the "Diagram 
View" in the data model. It provides a visual representation of 
the tables and their relationships

 In the Diagram View, you can drag and arrange tables, resize 
them, and adjust the layout for better readability

 Utilizing Relationships in Visualizations
 With relationships established, you can use them in your 

visualizations. For example, when creating a chart or a table, 
you can drag fields from multiple tables onto the canvas, and 
Power BI will automatically leverage the relationships to 
consolidate the data.


It's important to ensure the accuracy and integrity of your data 
model by creating appropriate relationships that reflect the logical 
connections between the tables. By doing so, you can seamlessly 
combine and analyze data across multiple tables in Power BI to 
gain valuable insights and create meaningful reports and 
dashboards.
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Implementing calculated columns and measures 
using DAX



Implementing calculated columns and measures using DAX (Data 
Analysis Expressions) in Power BI allows you to create custom 
calculations and aggregations based on your specific business 
requirements. DAX is a formula language that is used to extend the 
capabilities of Power BI and perform calculations within the data 
model. Here's an explanation of how to implement calculated 
columns and measures using DAX

 Understanding Calculated Columns
 Calculated columns are additional columns that you create 

in a table based on calculations using existing columns in 
that table

 To create a calculated column, navigate to the data model 
view in Power BI Desktop and select the table where you want 
to add the calculated column

 Right-click on the table and choose "New Column" from the 
context menu. Enter a name for the column and write the DAX 
formula that defines the calculation based on the existing 
columns

 For example, if you have a "Sales" table with "Quantity" and 
"Price" columns, you can create a calculated column named 
"Total Sales" using the formula: Total Sales = Quantity * Price

 Calculated columns become part of the table and can be 
used in visualizations as any other column

 Understanding Measures
 Measures are calculations performed on aggregated data 

and are typically used in numerical aggregations, such as 
sums, averages, counts, and percentages

 To create a measure, navigate to the data model view in 
Power BI Desktop and select the table where you want to 
define the measure

 In the Modeling tab, click on the "New Measure" button. Enter a 
name for the measure and write the DAX formula that defines 
the calculation based on the existing columns

 Measures are typically created using DAX functions that 
perform aggregations and calculations on the columns. For 
example, you can create a measure named "Total Sales" 
using the formula: Total Sales = SUM(Sales[Quantity] * 
Sales[Price])

 Measures can be used in visualizations, such as charts and 
tables, to show aggregated values based on different 
dimensions and filters.
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 Writing DAX Formulas
 DAX formulas use a combination of functions, operators, and 

references to columns and tables to perform calculations 
and aggregations

 DAX functions include mathematical functions (SUM, 
AVERAGE, MAX, MIN), logical functions (IF, AND, OR), date and 
time functions (TODAY, YEAR, MONTH), text functions 
(CONCATENATE, LEFT, RIGHT), and many more

 DAX formulas can reference columns within the same table or 
from other related tables using table and column names

 You can use operators like +, -, *, / for arithmetic calculations 
and comparison operators like =, <, > for logical conditions

 DAX formulas can also include conditional statements, nested 
functions, and variables to perform complex calculations

 Utilizing Calculated Columns and Measures
 Once created, calculated columns and measures can be 

used in visualizations and reports within Power BI
 In the Fields pane, you will find the calculated columns and 

measures listed under their respective tables
 Drag and drop the calculated columns or measures onto the 

canvas to create visualizations that leverage these 
calculations

 You can also combine calculated columns and measures 
with filters, slicers, and other visualizations to gain insights 
and perform interactive analysis.



By utilizing calculated columns and measures in Power BI using DAX, 
you can perform custom calculations, create derived columns, and 
aggregate data to meet specific analytical requirements. DAX 
provides a flexible and powerful language for data modeling and 
analysis within Power BI.
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Creating and customizing visuals in Power BI 
Desktop



Creating and customizing visuals in Power BI Desktop allows you to 
present your data in a visually appealing and informative way. 
Power BI offers a wide range of visualizations, including charts, 
tables, maps, and more. Here's an explanation of how to create and 
customize visuals in Power BI Desktop

 Creating Visuals
 Drag and Drop: In Power BI Desktop, navigate to the report or 

dashboard canvas. From the "Visualizations" pane on the right 
side, select the desired visualization type (e.g., bar chart, line 
chart, table). Drag the required fields from the "Fields" pane 
onto the canvas to create the visual

 Visualizations Pane: Alternatively, you can click on the desired 
visualization type in the "Visualizations" pane and select the 
required fields from the "Fields" pane. This will automatically 
create the visual on the canvas

 Customizing Visuals
 Visual Formatting: With the visual selected, you can customize 

its appearance by using the "Format" pane on the right side. 
This pane provides options to modify the visual's title, data 
labels, axis labels, colors, fonts, backgrounds, and more

 Interactions: Power BI allows you to define how visuals interact 
with each other. By selecting a visual and going to the 
"Format" pane, you can modify the "Interactions" setting to 
control how visuals respond to selection, filtering, and 
highlighting actions

 Analytics and Insights: The "Analytics" pane offers additional 
options to enhance visualizations with trend lines, reference 
lines, forecasting, clustering, and other statistical insights. 
These features provide deeper analysis and understanding of 
your data

 Conditional Formatting: Power BI allows you to apply 
conditional formatting to visuals, making it easier to highlight 
important data points based on specific conditions. With the 
visual selected, go to the "Format" pane and find the 
"Conditional formatting" options to define rules and 
formatting styles.

Module 3: Control Flow and 
Loops
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 Filtering and Slicing
 Power BI provides powerful filtering capabilities to focus on 

specific data subsets. You can apply filters directly to visuals 
by selecting data points or ranges within the visual. You can 
also use the "Filters" pane to add filters based on specific 
fields or criteria

 Slicers are interactive visual controls that allow users to filter 
data across multiple visuals at once. You can add slicers to 
the canvas by dragging the desired field from the "Fields" 
pane and selecting the slicer type (e.g., dropdown, checkbox, 
list)

 Arranging and Layout
 Power BI Desktop offers a flexible canvas where you can 

arrange and organize visuals. You can resize, move, and align 
visuals as needed to create an appealing layout

 Power BI supports various layout options, such as using grids 
and guidelines to align visuals, snapping visuals to each 
other, and using containers to group visuals together

 Cross-Page and Drillthrough
 Power BI allows you to create cross-page navigation and 

drillthrough actions to enhance user interactivity. You can set 
up navigation from one page to another by adding buttons or 
visuals with custom hyperlink actions. Drillthrough actions 
enable users to explore additional details by focusing on 
specific data points within a visual

 Interactive Visualizations
 Power BI visuals support interactivity and data exploration. 

Users can hover over data points to view tooltips, zoom in/out 
on visuals, use the selection pane to control visibility of 
visuals, and use the "Focus mode" to isolate specific visuals 
for deeper analysis.



By creating and customizing visuals in Power BI Desktop, you can 
effectively communicate your data insights and engage viewers 
with interactive and informative visual representations. Experiment 
with different visual types, formatting options, and interactivity 
features to create visually compelling reports and dashboards.
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Using different types of visualizations



Power BI provides a wide range of visualizations to present your 
data in various formats, each suited for different types of analysis 
and data representation. Here's an explanation of different types of 
visualizations available in Power BI and their use cases

 Bar Chart
 Bar charts display data using horizontal or vertical bars, with 

the length or height of each bar representing the data value
 Use bar charts to compare data across different categories 

or to show trends over time
 Column Chart

 Similar to bar charts, column charts represent data using 
vertical bars

 Column charts are useful for comparing values across 
different categories or groups

 Line Chart
 Line charts display data as a series of points connected by 

lines, showing trends or patterns over time or other 
continuous scales

 Use line charts to visualize data changes, trends, and 
comparisons over time

 Pie Chart
 Pie charts represent data as a circle divided into slices, with 

each slice representing a category and its proportionate 
value

 Pie charts are suitable for showing the composition or 
distribution of a whole, especially when comparing parts of a 
whole

 Area Chart
 Area charts are similar to line charts, but the area beneath 

the line is filled, emphasizing the cumulative value
 Use area charts to show cumulative values, trends, or stacked 

proportions over time
 Scatter Plot

 Scatter plots display individual data points as dots on a 
graph, with each dot representing a combination of two 
variables

 Scatter plots are useful for identifying relationships, 
correlations, or clusters between two variables.
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 Map
 Maps visualize data geographically, showing data points or 

regions on a map
 Use maps to display regional data, spatial patterns, or to 

perform geographic analysis
 Table

 Tables present data in a structured format, with rows and 
columns

 Use tables to display detailed data, comparisons, or to 
provide a tabular view of the dataset

 Matrix
 Matrices are similar to tables but provide more flexibility by 

allowing data to be summarized and grouped by rows and 
columns

 Use matrices for multidimensional data analysis, summaries, 
or cross-tabulations

 Card
 Cards display a single value or metric in a visually appealing 

format
 Use cards to highlight key metrics, KPIs, or to showcase single 

values
 Gauge

 Gauges present data as a dial or a gauge-like visualization, 
representing a single value within a range or target

 Use gauges to visualize progress towards goals, performance 
indicators, or thresholds

 Tree Map
 Tree maps use rectangles to represent hierarchical data, with 

the size and color of each rectangle indicating the values
 Tree maps are ideal for displaying hierarchical proportions or 

nested data structures
 Funnel Chart

 Funnel charts represent a series of steps or stages in a 
process, with the width of each section representing the 
quantity or value at that stage

 Use funnel charts to visualize sales or conversion processes, 
showing the drop-off or progression at each stage.


These are just a few examples of the visualizations available in 
Power BI. It's important to choose the appropriate visualization 
based on the type of data, the insights you want to convey, and the 
audience you are targeting. Experiment with different visualizations 
and consider the context and purpose of your data to effectively 
communicate your message and insights.
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Applying formatting and interactive features



Applying formatting and interactive features to your visualizations 
in Power BI allows you to enhance the aesthetics, readability, and 
interactivity of your reports and dashboards. Here's an explanation 
of how to apply formatting and use interactive features in Power BI

 Formatting Visuals
 Select the visual you want to format by clicking on it
 Use the "Format" pane on the right side of the screen to 

access various formatting options
 In the "Format" pane, you can modify properties such as title, 

data labels, axis labels, legends, colors, fonts, backgrounds, 
and more

 Customize the visual's appearance by adjusting these 
properties according to your preferences and the 
requirements of your report or dashboard

 Conditional Formatting
 Power BI allows you to apply conditional formatting to your 

visualizations based on specific rules or criteria
 With a visual selected, go to the "Format" pane and find the 

"Conditional formatting" options
 Define conditional rules based on data values, and specify 

formatting styles such as colors, font sizes, or data bars that 
will be applied when the conditions are met

 Conditional formatting helps highlight important data points 
and patterns, making it easier for users to interpret the 
visualizations

 Interactions between Visuals
 Power BI enables interactions between different visuals in a 

report or dashboard, allowing users to explore and analyze 
the data dynamically

 To set up interactions, select a visual, go to the "Format" pane, 
and find the "Interactions" options

 Define how the selected visual should behave when other 
visuals are interacted with, such as filtering, highlighting, or 
cross-highlighting

 You can control the interaction behavior at different levels, 
such as page level, visual level, or report level, depending on 
your requirements.
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 Filters and Slicers
 Power BI provides filtering capabilities to focus on specific 

data subsets within visualizations
 Select a visual, go to the "Filters" pane, and add filters based 

on specific fields or criteria
 Users can interact with filters directly on visuals by selecting 

data points or ranges within the visual
 Slicers are interactive visual controls that allow users to filter 

data across multiple visuals simultaneously
 To add a slicer, drag the desired field from the "Fields" pane 

onto the canvas and choose the slicer type (e.g., dropdown, 
checkbox, list)

 Configure slicers to filter data within visuals or across the 
entire report or dashboard

 Drillthrough
 Power BI supports drillthrough actions, allowing users to 

navigate to more detailed information based on specific data 
points within a visual

 Set up drillthrough actions by selecting a visual, going to the 
"Format" pane, and configuring the drillthrough options

 Define the drillthrough fields and the destination report page 
that should be displayed when users interact with the 
specified data points

 Drillthrough enhances data exploration and allows users to 
focus on specific aspects of the data for deeper analysis

 Bookmarks and Buttons
 Power BI allows you to create bookmarks, which capture the 

current state of a report or dashboard, including applied 
filters, slicer selections, and visual interactions

 Use bookmarks to save specific views or analysis 
perspectives and enable users to navigate between them

 Create buttons on the canvas to trigger actions, such as 
applying a bookmark, navigating to a different report page, or 
opening a URL

 Buttons can be customized with text, icons, or images, 
providing an intuitive way for users to interact with the report 
or dashboard.
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Creating and managing hierarchies and drill-
through actions



Creating and managing hierarchies and drill-through actions in 
Power BI allows you to organize and navigate through data in a 
structured and intuitive manner. Hierarchies provide a way to group 
related data fields together, while drill-through actions enable users 
to access detailed information from summary visualizations. Here's 
an explanation of how to create and manage hierarchies and drill-
through actions in Power BI

 Creating Hierarchies
 Hierarchies in Power BI allow you to organize related fields into 

a structured format, enabling easier navigation and analysis
 To create a hierarchy, go to the "Fields" pane in Power BI 

Desktop
 Select the fields you want to include in the hierarchy and 

right-click on one of the selected fields
 Choose "New Hierarchy" from the context menu and provide a 

name for the hierarchy
 Power BI will create a new hierarchy with the selected fields as 

levels, where the top-level field represents the broadest 
category and subsequent levels provide increasing levels of 
detail

 Managing Hierarchies
 Once a hierarchy is created, you can manage its properties 

and behavior
 In the "Fields" pane, locate the hierarchy you want to manage
 Expand the hierarchy to see its levels and fields
 You can reorder the levels by dragging and dropping them 

within the hierarchy
 To include or exclude fields from the hierarchy, drag and drop 

them onto or outside of the hierarchy structure
 You can also rename the levels or the entire hierarchy by 

right-clicking on them and selecting "Rename".
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 Using Hierarchies
 Hierarchies can be used in various visualizations and analysis 

scenarios
 Drag and drop the hierarchy onto the visualization canvas to 

create a visual that automatically expands and collapses the 
hierarchy levels

 You can drill down into the hierarchy by interacting with the 
visual, revealing more detailed information as you navigate 
through the levels

 Hierarchies can also be used in filters and slicers, allowing 
users to filter and slice data based on different levels of the 
hierarchy

 Creating Drill-through Actions
 Drill-through actions enable users to access detailed 

information from summary visualizations by clicking or 
selecting specific data points

 To create a drill-through action, open the report in Power BI 
Desktop

 Select the visual from which you want to enable drill-through
 In the "Visualizations" pane, navigate to the "Format" section 

and find the "Drillthrough" option
 Enable drill-through and specify the fields that will be used for 

drilling through
 Next, create a new report page that will display the detailed 

information
 Customize the new page with visuals and filters that provide 

the desired level of detail
 Users can now drill through by right-clicking a data point or 

using a specified gesture, opening the detailed page with 
relevant context

 Managing Drill-through Actions
 To manage drill-through actions, go to the "View" tab in Power 

BI Desktop
 Click on "Drillthrough" to access the drill-through settings
 Here, you can modify existing drill-through actions, add new 

ones, or remove drill-through configurations
 You can also specify the visual elements (e.g., buttons, 

images) that trigger the drill-through action on the report 
canvas.
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Designing interactive reports with multiple pages 
and visuals



Designing interactive reports with multiple pages and visuals in 
Power BI allows you to create comprehensive and engaging data 
narratives. By structuring your report into multiple pages and 
incorporating various visuals, you can present information in a 
cohesive and interactive manner. Here's an explanation of how to 
design interactive reports with multiple pages and visuals in Power 
BI

 Planning Your Report
 Define the objective and purpose of your report. Determine 

the key insights you want to convey and the target audience
 Identify the data sources and the main aspects of the data 

you want to highlight
 Plan the structure of your report by breaking it into logical 

sections or topics
 Consider the sequence of pages and the flow of information 

that makes the most sense for your report
 Creating Pages

 In Power BI Desktop, select the "Home" tab and click on "New 
Page" to create a new report page

 Repeat this step for each page you want to include in your 
report

 Give each page a descriptive name that reflects its content or 
purpose

 Adding Visuals
 On each page, select the desired visualizations from the 

"Visualizations" pane on the right side
 Drag and drop the fields from the "Fields" pane onto the 

visualizations to populate them with data
 Customize the visuals by formatting their appearance, 

applying conditional formatting, and adjusting their layout as 
needed

 Use a mix of visual types to represent different aspects of the 
data and to cater to different types of analysis (e.g., bar 
charts, line charts, tables, maps).

Module 4: Building 
Interactive Reports and 
Dashboards
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 Adding Interactivity
 Enhance the interactivity of your report by configuring 

interactions between visuals and providing filtering options
 Select a visual, go to the "Format" pane, and define how it 

should interact with other visuals on the page or across the 
report

 Utilize slicers and filters to allow users to dynamically control 
the data they see

 Add buttons or bookmarks to enable navigation between 
different pages or to apply predefined views

 Creating Navigation
 Use the "Selection pane" to manage the visibility and order of 

visuals on each page
 Arrange visuals in a logical and visually appealing manner, 

considering the flow of information
 Add buttons or hyperlinks to facilitate navigation between 

pages or to external resources
 Create a table of contents or a summary page with links to 

different sections of the report
 Testing and Reviewing

 Preview your report to ensure that the visuals and interactions 
are working as intended

 Test the report with sample data to verify that the insights 
and story you want to convey are effectively communicated

 Share the report with colleagues or stakeholders for feedback 
and review

 Publishing and Sharing
 Once you're satisfied with your interactive report, publish it to 

the Power BI service
 Share the report with specific individuals or groups, or make it 

accessible to a broader audience
 Set up appropriate permissions and access controls to 

ensure data security and privacy.

By designing interactive reports with multiple pages and visuals in 
Power BI, you can create a rich and immersive data experience for 
your audience. Carefully plan the structure and flow of your report, 
incorporate various visualizations, and leverage interactivity to 
empower users to explore the data and gain valuable insights.
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Adding slicers, filters, and bookmarks for 
interactivity



Adding slicers, filters, and bookmarks in Power BI enhances 
interactivity in your reports and allows users to dynamically control 
and explore the data. Here's an explanation of how to add and 
utilize these interactive features

 Slicers
 Slicers are visual controls that enable users to filter data and 

focus on specific subsets of information
 To add a slicer, go to the "Visualizations" pane in Power BI 

Desktop
 Drag and drop the desired field onto the canvas, and it will 

automatically be converted into a slicer
 Configure the slicer's settings, such as the type (dropdown, 

list, or checkbox), style, layout, and interaction behavior
 Users can interact with the slicer by selecting or deselecting 

options, which will dynamically update the visuals based on 
the applied filter

 Filters
 Filters in Power BI allow users to apply specific criteria to limit 

the data shown in visualizations
 Filters can be applied to individual visuals or to the entire 

report
 To apply a filter to a visual, select the visual, go to the 

"Visualizations" pane, and find the "Filters" section
 Add the desired fields to the filter section and define the 

filtering criteria (e.g., equals, greater than, between)
 Users can interact with the filter by selecting different options 

or values, and the visual will update accordingly.
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 Bookmarks
 Bookmarks capture the current state of a report, including 

applied filters, slicer selections, and visual interactions
 Bookmarks allow you to save specific views or analysis 

perspectives and enable users to navigate between them
 To create a bookmark, go to the "View" tab in Power BI 

Desktop
 Set up the report page with the desired filters, slicer 

selections, and visual interactions
 Click on "Add Bookmark" and provide a name for the 

bookmark
 Customize the bookmark's settings, such as the display state 

of visuals and the visibility of other report elements
 Users can interact with bookmarks by clicking on buttons or 

links that you create, or by using the bookmark pane to select 
a specific bookmark

 Utilizing Interactivity
 Combine slicers, filters, and bookmarks to provide a rich 

interactive experience in your report
 Use slicers to allow users to filter data based on different 

dimensions or criteria
 Apply filters to individual visuals to focus on specific data 

points or subsets
 Create bookmarks for different report views, such as 

summary, detailed, or comparison perspectives
 Add buttons or hyperlinks to navigate between different 

bookmarks or pages within the report
 Customize the visuals and interactions based on the specific 

requirements of your report and the preferences of your 
users.


By adding slicers, filters, and bookmarks in your Power BI reports, 
you enable users to explore the data, drill down into details, and 
customize their viewing experience. These interactive features 
empower users to extract meaningful insights from the data and 
interact with the report in a way that suits their analysis needs.
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Publishing reports from Power BI Desktop to 
Power BI Service



Publishing reports from Power BI Desktop to Power BI Service allows 
you to share your reports with others, collaborate on them, and 
access them from anywhere using a web browser or mobile app. 
Here's an explanation of how to publish reports from Power BI 
Desktop to Power BI Service

 Prepare your Report
 Ensure that your report in Power BI Desktop is complete and 

ready for publishing
 Verify that all visualizations, data sources, and connections 

are working correctly
 Consider optimizing your report for the web by removing 

sensitive data, optimizing visuals for performance, and setting 
appropriate access permissions

 Sign in to Power BI Service
 Open Power BI Desktop and click on the "Publish" button in the 

toolbar or go to the "File" menu and select "Publish"
 Sign in to Power BI

 If you are not already signed in, you will be prompted to sign 
in to your Power BI account

 Enter your credentials (username and password) to log in
 Choose Destination

 After signing in, you will see the "Publish to Power BI" dialog 
box

 Choose the destination workspace or workspace app where 
you want to publish your report

 If needed, you can also create a new workspace directly from 
this dialog box.
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 Configure Settings
 Optionally, you can configure additional settings before 

publishing your report
 Select the desired privacy level for the report (e.g., Public, My 

Organization, Specific People) to control who can access it
 Choose whether to include external data connections, so 

others can refresh the data in Power BI Service
 You can also specify additional options, such as enabling 

row-level security or allowing export of data
 Publish the Report

 Once you have configured the settings, click on the "Publish" 
button to start the publishing process

 Power BI Desktop will upload the report, along with its visuals, 
data model, and connections, to the selected workspace in 
Power BI Service

 The progress will be shown in the notification area, and a 
success message will be displayed upon completion

 Access the Published Report
 Open Power BI Service in a web browser
 Navigate to the workspace where you published the report
 You will find your report listed among the reports in that 

workspace
 Click on the report to open and interact with it in the Power BI 

Service interface
 From here, you can view, share, collaborate, and distribute the 

report to other users within your organization.



By publishing your reports from Power BI Desktop to Power BI 
Service, you can take advantage of the collaborative features and 
accessibility offered by the service. This allows you and others to 
access and interact with the report from anywhere, share it with 
colleagues or clients, and collaborate on the analysis and insights 
provided by the report.
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Sharing and collaborating on reports and 
dashboards with others



Sharing and collaborating on reports and dashboards in Power BI 
enables you to work collaboratively with others, share insights, and 
collectively analyze and make data-driven decisions. Here's an 
explanation of how to share and collaborate on reports and 
dashboards with others in Power BI

 Share Reports and Dashboards
 In Power BI Service, open the report or dashboard you want to 

share
 Click on the "Share" button in the top-right corner of the 

screen
 Enter the email addresses or distribution groups of the people 

you want to share the report or dashboard with
 Choose the appropriate access level for each user, such as 

"Viewer," "Contributor," or "Admin." You can also add a custom 
message if desired

 Optionally, you can also set an expiration date for the sharing 
link or require users to sign in to access the report

 Click on "Send" to share the report or dashboard with the 
selected users

 Collaborate on Reports and Dashboards
 Shared users can access the report or dashboard through the 

sharing link or by navigating to it in their Power BI Service 
account

 Users with "Contributor" or "Admin" access can make edits 
and updates to the report or dashboard

 Collaboration features include the ability to add comments, 
reply to comments, and tag specific users to draw attention 
to specific sections or insights

 Users can also create and share their own visuals, add 
bookmarks, or pin visuals to dashboards

 Co-Authoring
 Power BI supports co-authoring, allowing multiple users to 

work simultaneously on the same report or dashboard
 When multiple users open the same report or dashboard, 

they can see each other's changes in real-time
 Co-authors can make updates, create new visuals, apply 

filters, and perform other actions while maintaining a shared 
view of the report.
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 Notifications and Subscriptions
 Power BI provides notifications and subscription options to 

keep users informed about updates and changes to reports 
and dashboards

 Users can subscribe to receive email notifications when 
specific data changes, new visuals are added, or specific 
events occur

 Notifications help users stay updated and informed about the 
latest insights and changes in the shared reports or 
dashboards

 Export and Download Options
 Users can export and download reports and dashboards from 

Power BI in various formats, such as PDF, PowerPoint, Excel, or 
CSV

 This enables users to share reports offline or integrate them 
into other documents or presentations.



By sharing and collaborating on reports and dashboards in Power 
BI, you can leverage the collective knowledge and expertise of your 
team or organization. Collaboration features such as comments, 
co-authoring, notifications, and subscriptions enable efficient 
teamwork, data exploration, and decision-making based on shared 
insights. This fosters a collaborative data culture, driving the use of 
data for better decision-making across your organization.
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Advanced DAX functions and calculations



Advanced DAX (Data Analysis Expressions) functions and 
calculations in Power BI allow for more sophisticated data 
manipulation, modeling, and analysis. DAX is a formula language 
used in Power BI to create custom calculations, measures, and 
calculated columns. Here's an explanation of some advanced DAX 
functions and calculations

 Aggregation Functions
 DAX provides various aggregation functions, such as SUM, 

AVERAGE, MIN, MAX, COUNT, COUNTA, DISTINCTCOUNT, etc
 These functions allow you to perform calculations based on 

aggregated values of a column or expression
 Aggregation functions are commonly used in measures to 

calculate metrics like total sales, average revenue, or 
maximum profit

 Statistical Functions
 DAX offers statistical functions for advanced data analysis
 Functions like STDEV.P (population standard deviation), 

STDEV.S (sample standard deviation), VAR.P (population 
variance), VAR.S (sample variance), etc., allow you to 
calculate statistical measures on your data

 These functions are useful for understanding data 
distribution, variability, and trends

 Time Intelligence Functions
 Time intelligence functions in DAX enable analysis over time-

based data, such as dates, months, quarters, and years
 Functions like SAMEPERIODLASTYEAR, TOTALYTD, 

PREVIOUSMONTH, etc., help in creating year-over-year 
comparisons, calculating running totals, and analyzing trends 
over time

 Time intelligence functions are commonly used in measures 
to provide insights into performance, seasonality, and growth 
patterns.



Module 5: Advanced Data 
Analysis and 
Administration
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 Rank and Percentile Functions
 DAX includes functions for calculating ranks and percentiles 

in a dataset
 Functions like RANKX, PERCENTILE.INC, and PERCENTILE.EXC 

allow you to determine the relative position or distribution of a 
value within a dataset

 These functions are useful for analyzing data in terms of its 
relative standing or distribution, such as finding the top-
selling products or identifying outliers

 Advanced Filter Functions
 DAX provides advanced filtering functions for more complex 

filtering conditions
 Functions like FILTER, CALCULATE, and ALL allow you to define 

complex filtering expressions based on multiple criteria or 
logical conditions

 These functions are useful for creating dynamic calculations 
or measures that consider specific subsets of data based on 
complex conditions

 Text and String Functions
 DAX offers a range of text and string functions for 

manipulating and analyzing text data
 Functions like CONCATENATE, LEFT, RIGHT, MID, LEN, SUBSTITUTE, 

UPPER, LOWER, etc., allow you to perform operations like 
concatenation, extraction, substitution, and formatting on text 
values

 Text and string functions are helpful for data cleaning, data 
transformation, and creating more meaningful labels or 
descriptions in your reports

 Advanced Calculations with IF, SWITCH, and CASE
 DAX supports conditional logic with functions like IF, SWITCH, 

and CASE
 These functions allow you to define conditional expressions or 

perform different calculations based on specific conditions
 Conditional functions are useful for creating calculated 

columns or measures that adjust calculations based on 
different scenarios or business rules.


These are just a few examples of the advanced DAX functions and 
calculations available in Power BI. By leveraging these functions, 
you can create more sophisticated and customized calculations, 
measures, and columns to analyze and visualize your data 
effectively. It is recommended to refer to the official DAX 
documentation and explore additional functions and capabilities to 
meet your specific data analysis requirements.
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Working with R and Python scripts in Power BI



Working with R and Python scripts in Power BI allows you to leverage 
the power of these programming languages for advanced data 
analysis, statistical modeling, and machine learning within your 
Power BI reports and dashboards. Here's an explanation of how to 
work with R and Python scripts in Power BI

 Enabling R and Python Integration
 By default, Power BI Desktop supports the integration of R and 

Python scripts
 Ensure that R and/or Python is installed on your machine and 

configured correctly
 In Power BI Desktop, go to "File" > "Options and settings" > 

"Options" > "R Scripting" or "Python scripting" and enable the 
respective scripting language

 Adding R or Python Visuals
 In Power BI Desktop, go to the "Visualizations" pane and click 

on the "R" or "Python" visual icon
 Drag and drop the desired fields onto the visual canvas
 Write the necessary R or Python script in the script editor 

provided
 The script can include data manipulation, statistical analysis, 

machine learning algorithms, or any custom code specific to 
your analysis requirements

 The script will be executed, and the output will be displayed 
as a visual within your Power BI report

 Passing Data to Scripts
 You can pass data from your Power BI dataset to R or Python 

scripts for analysis
 Use the "R Script" or "Python Script" functions in Power Query 

Editor to execute scripts and transform data before loading it 
into Power BI

 Alternatively, you can use the "R Script" or "Python Script" 
custom columns feature to apply scripts to individual rows of 
data.
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 Using R and Python Libraries
 R and Python have extensive libraries for various data 

analysis, statistical modeling, and machine learning tasks
 In your R or Python scripts, you can import and utilize these 

libraries to leverage their functionality
 Install the required libraries using the respective package 

managers (e.g., install.packages() in R, pip install in Python)
 Import the libraries into your script using the library() or 

import statements
 Interacting with Power BI Data

 R and Python scripts in Power BI can access and manipulate 
data from Power BI datasets

 Use the Power BI APIs or libraries specific to R (e.g., 
"RevoScaleR") or Python (e.g., "pandas") to interact with Power 
BI data

 Read data from Power BI into your script, perform analysis or 
modeling, and write the results back to Power BI for 
visualization or further analysis

 Refreshing Data and Security Considerations
 When using R or Python scripts in Power BI, ensure that the 

data refresh settings are configured properly
 Power BI can refresh the data and re-run the scripts based on 

the defined refresh schedule or on-demand
 Consider security implications when working with external 

scripts, ensuring that access to the script environment, data 
sources, and packages is controlled and secure.



Working with R and Python scripts in Power BI expands the 
analytical capabilities by leveraging the extensive libraries and 
functionalities of these programming languages. It enables 
advanced statistical analysis, machine learning, and custom data 
manipulations within your Power BI reports and dashboards, 
providing deeper insights and more sophisticated data-driven 
decision-making.
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Configuring data refresh and scheduling in Power 
BI Service



Configuring data refresh and scheduling in Power BI Service allows 
you to ensure that your reports and dashboards stay up to date 
with the latest data from your data sources. Here's an explanation 
of how to configure data refresh and scheduling in Power BI Service

 Data Sources
 Ensure that your data sources are supported for refresh in 

Power BI Service. Common data sources like SQL databases, 
Excel files, SharePoint lists, and cloud services are usually 
supported. However, some data sources may require 
additional configuration or gateways for refresh

 Gateway Configuration (if required)
 If your data sources are located on-premises or in a private 

network, you may need to install and configure an On-
premises data gateway in Power BI Service

 The gateway allows secure communication between Power BI 
Service and your on-premises data sources, enabling data 
refresh from those sources

 Import or DirectQuery Mode
 Determine the refresh mode for your data sources in Power BI 

Service
 Import Mode: In this mode, data is imported and stored within 

Power BI Service, and refresh retrieves the latest data from the 
source on a scheduled basis

 DirectQuery Mode: In this mode, Power BI Service connects 
directly to the data source, and any queries or visualizations 
are executed in real-time against the source. In DirectQuery 
mode, there is no need for data refresh

 Setting up Scheduled Refresh
 Open the Power BI Service web portal and navigate to the 

dataset you want to configure refresh for
 Click on the ellipsis (...) next to the dataset and select 

"Settings" > "Scheduled refresh.
 Enable the "Keep your data up to date" toggle switch
 Specify the frequency and time for data refresh. You can 

choose daily, weekly, or set a custom schedule
 Configure any additional options, such as allowing data 

refresh on a failure, setting up notifications, or enabling 
parallel loading for faster refresh.
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 Refresh Settings
 Specify the credentials or authentication method required to 

access the data source during refresh
 Depending on your data source, you may need to provide 

credentials like username and password, or configure 
Windows authentication, OAuth, or other authentication 
methods

 Testing and Validating Refresh
 After setting up the refresh schedule and configuration, it's 

essential to test and validate the refresh process
 Click on the "Refresh Now" button to manually trigger a refresh 

and verify that it completes successfully
 Monitor the refresh history and any error messages to 

troubleshoot and resolve any issues that may arise.



Note: Data refresh may have limitations depending on your Power BI 
license and the data source type. Some data sources may have 
restrictions on the number of refreshes per day or the amount of 
data that can be refreshed. Ensure that you review and understand 
the refresh limitations specific to your data sources and Power BI 
license.



By configuring data refresh and scheduling in Power BI Service, you 
ensure that your reports and dashboards are always up to date 
with the latest data from your sources. This allows users to access 
the most current information and make informed decisions based 
on real-time or near-real-time data.
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Implementing security and data protection best 
practices



Implementing security and data protection best practices in Power 
BI is crucial to ensure the confidentiality, integrity, and availability of 
your data. Here's an explanation of some key considerations and 
practices for enhancing security in Power BI

 Access and Authentication
 Utilize strong authentication methods, such as Azure Active 

Directory (Azure AD) for user authentication in Power BI
 Implement Multi-Factor Authentication (MFA) to add an extra 

layer of security for user logins
 Use Azure AD groups to manage access permissions and 

roles in Power BI, ensuring that users only have access to the 
data and reports they need

 Regularly review and update user access permissions to align 
with changes in roles and responsibilities

 Row-level Security (RLS)
 Implement Row-level Security (RLS) to restrict data access 

based on user roles or attributes
 RLS allows you to define filters on tables or columns to limit 

the data that users can see, based on their roles or attributes
 This ensures that sensitive data is protected and users only 

see the data relevant to their role or context
 Data Encryption

 Use SSL/TLS encryption for data transmission between Power 
BI and data sources to protect data in transit

 Encrypt sensitive data at rest in your data sources, ensuring 
that the data remains encrypted even when stored

 Data Classification and Sensitivity Labels
 Classify your data based on its sensitivity level (e.g., public, 

internal, confidential) and apply sensitivity labels accordingly
 Power BI supports sensitivity labels to enforce data protection 

policies and access controls based on the sensitivity level of 
the data.
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 Data Gateway Security
 If using an On-premises data gateway, ensure that it is 

installed and configured securely
 Regularly update the gateway software to stay protected 

against security vulnerabilities
 Use the recommended security practices for configuring and 

managing the gateway, such as firewall rules, network 
segmentation, and access controls

 Secure Data Sharing
 Be cautious when sharing reports and dashboards externally
 Use the appropriate sharing options and access controls to 

ensure that only authorized users can access and view the 
shared content

 Avoid sharing sensitive or confidential information externally 
unless necessary, and implement additional protections such 
as watermarking or restricted sharing

 Monitor and Audit Activity
 Enable auditing and monitoring features in Power BI to track 

user activities and detect any unauthorized access or 
unusual behavior

 Regularly review audit logs and security reports to identify 
and respond to any potential security incidents

 Stay Up-to-date with Security Updates
 Keep your Power BI environment, including Power BI Desktop 

and Power BI Service, up to date with the latest security 
updates and patches

 Regularly review and apply security updates to protect 
against known vulnerabilities

 User Education and Awareness
 Educate users on security best practices, such as strong 

passwords, avoiding sharing credentials, and being cautious 
with external sharing

 Promote a culture of security awareness and provide training 
to users on data protection and privacy.


It's important to note that security is a continuous process, and it 
requires regular monitoring, assessment, and adaptation to 
evolving threats and best practices. Stay informed about the latest 
security guidance from Microsoft and other security resources to 
ensure that your Power BI implementation remains secure and 
compliant with data protection regulations.
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Monitoring and optimizing Power BI performance



Monitoring and optimizing Power BI performance is essential to 
ensure that your reports and dashboards deliver a smooth and 
efficient user experience. Here's an explanation of some key 
practices for monitoring and optimizing Power BI performance

 Data Source Performance
 Ensure that the performance of your underlying data sources, 

such as databases or APIs, is optimized
 Monitor the query performance and response times of your 

data sources
 Identify and address any bottlenecks or inefficiencies in data 

retrieval or processing at the source
 Query Optimization

 Optimize the queries executed against your data sources 
within Power BI

 Use efficient query design techniques, such as minimizing the 
use of unnecessary joins, filters, or calculations

 Leverage query folding to push as much processing as 
possible to the data source, reducing data transfer and 
processing in Power BI

 Data Modeling and Relationships
 Design your data model in Power BI with performance in 

mind
 Avoid creating unnecessary relationships between tables that 

can impact query performance
 Optimize the cardinality and direction of relationships based 

on the data access patterns
 Consider using calculated tables or materialized views to 

pre-aggregate or pre-calculate data to improve query 
performance

 Calculation Optimization
 Review the performance of your calculations, measures, and 

DAX expressions
 Optimize calculations by removing unnecessary complexity 

or redundant calculations
 Use techniques like query context optimization, avoiding 

unnecessary iterations, and leveraging DAX optimizations like 
SUMMARIZE, CALCULATE, or EVALUATE functions.
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 Data Refresh Performance
 Monitor and optimize the performance of data refresh 

operations
 Optimize the data refresh schedule to minimize disruption to 

users while ensuring data is up to date
 Consider incremental refresh options to only refresh a subset 

of data that has changed, reducing refresh times
 Report Design Best Practices

 Follow best practices for report design to enhance 
performance

 Limit the number of visuals and elements on a single report 
page to reduce rendering and processing times

 Optimize visuals by using appropriate visual types, filtering, 
and aggregating data at the visual level rather than relying 
on complex calculations

 Power BI Performance Analyzer
 Utilize the Power BI Performance Analyzer to identify 

performance bottlenecks
 Use Performance Analyzer to analyze query times, data 

loading times, and rendering times for each visual
 Identify slow-performing visuals or queries and optimize them 

accordingly
 Power BI Premium or Power BI Pro with Paginated Reports

 Consider utilizing Power BI Premium or Power BI Pro with 
Paginated Reports for enhanced performance and scalability

 Premium capacity offers dedicated resources and faster 
performance for larger datasets and complex reports

 Monitoring and Diagnostics
 Leverage monitoring tools and features provided by Power BI, 

such as Usage Metrics and Performance Analyzer
 Monitor the health and performance of your Power BI 

environment, including the usage patterns, dataset sizes, and 
report response times

 Use diagnostic tools and reports to identify potential issues, 
such as long-running queries or excessive resource 
consumption.
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In conclusion, Power BI is a powerful and versatile business 
intelligence tool that allows you to transform raw data into 
meaningful insights and interactive visualizations. Through this 
tutorial, we have covered various aspects of Power BI, including its 
components, installation, data import, data transformation, 
visualization creation, formatting, collaboration, and advanced 
features like DAX calculations, R and Python integration, and data 
refresh.

Power BI Desktop serves as the primary tool for creating reports and 
dashboards, enabling you to import data from various sources, 
shape and transform it using Power Query Editor, establish 
relationships between tables, and create calculated columns and 
measures using DAX expressions. You can then design visually 
appealing and interactive visuals, leverage different types of 
visualizations to convey information effectively, apply formatting 
options, and add interactive features such as slicers, filters, 
hierarchies, and drill-through actions to enhance interactivity.

Once your reports are ready, you can publish them to Power BI 
Service, the cloud-based platform, and share them with others. 
Power BI Service provides additional features like data refresh and 
scheduling, collaboration and sharing capabilities, security and 
data protection options, as well as the ability to create and manage 
interactive dashboards and reports with multiple pages and 
visuals. You can also utilize advanced functions, such as R and 
Python scripting, to extend the capabilities of Power BI and perform 
advanced analytics.

Throughout the tutorial, we have emphasized the importance of 
monitoring and optimizing Power BI performance. By considering 
factors such as data source performance, query optimization, 
efficient data modeling, report design best practices, and utilizing 
monitoring tools, you can ensure that your Power BI solution delivers 
a seamless user experience and timely insights.

Power BI offers a comprehensive and user-friendly environment for 
data analysis and reporting, empowering users to make informed 
decisions based on their data. By mastering the concepts and 
techniques covered in this tutorial, you can harness the full 
potential of Power BI and unlock valuable insights to drive your 
business forward.


Conclusion







Thank you


